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“Just because you can, doesn’t mean you
should.”

That has to be my favorite line of all time. No
matter how you read it, just because you CAN
do something, doesn’t mean that you necessarily
should do it. It promotes restraint and careful
deliberation before going off half-cocked and
doing something merely because you can, and
without fully understanding/appreciating/
discovering the ramifications and consequences
of your actions.

This is how I feel about the emergence of the AI
chatbots. And, it’s not because I’m against the
emergence of AI chatbots. That part is
inevitable. For me, it comes down to timing.
These chatbots couldn’t have possibly emerged
at a worse time. Let me explain.

We, as a people, are more divided now than
probably at any time in human history. We are
divided along social, economic, racial, religious,
political, and ideological lines (and virtually
every other dividing line you can imagine) more
greatly now than ever.

As such, disinformation and misinformation
campaigns tend to rule the flow of information.
That flow is torrential, as each “side” in the
ongoing disputes tries to get “their message”
across to the greatest number of people. Much
of the time, the “winner” in these battles tend to
be those who make the most noise, without

regard for the truth. All sides in these battles are
at fault, so I’m not pointing fingers at any
“side.” This makes it difficult for individuals
who are seeking the truth to be able to discern
what of the information, disinformation and
misinformation flow is truth and which is just
static falsehoods.

NOW, we get AI chatbots who can write plays,
movies, research papers, dissertations, poetry,
novels, etc., etc., etc. With the line of truth
already so obliterated and/or blurred, this isn’t
the best time for the emergence of chatbots.

Personally, I’ve avoided the new AI chatbots
like the dog tries to avoid fleas. AI chatbots are
definitely in their infancy, and should only
improve as time goes on. But we also need some
controls on these chabots. In more extreme
views, I sometimes have visions of an AI
monstrosity like Skynet in the Terminator
movies. Unless their use is restricted and their
abilities rolled out more slowly to give people a
chance to get use to their capabilities, the line of
truth could very easily be more easily blurred
and/or obliterated.

We are already losing our ability to “think for
ourselves” as mob mentality grips the various
factions of division and those that subscribe to
the ideas pushed by those factions. It would
only complicate resolution of those differences
to the nth degree if/when AI chatbots make the
truth even harder to obtain.

I’m not against the use of AI (as you’ll see).
Like I mentioned earlier, its use and steady
improvement over time is inevitable. But, I do
think its rollout should proceed at a slower pace,
one which will give us time to implement some
much needed safeguards.

Father-Daughter dance, March 2023

From The Chief Editor's Desk
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********************
This month’s cover was created by an AI image
creator, called DALL-E. The website allows you
to type in a plain text description of what you
are wanting a picture of, and then generates that
picture. My “generation” text was “Cartoonish
Linux mascot Tux dressed as the Easter Bunny,
in a large green meadow with mounds of Easter
candy and Easter eggs strewn all about.” The
site is literally getting hammered, as people give
it a try. It took probably about 10 or so times of
me hitting the “Generate” button to finally get
results. All of the other times, I kept getting
messages that the server-load was high, and to
try again later. However, once the server was
able to complete my request, DALL-E gave me
four results to choose from. This image is one of
those four, and the ONLY one that actually had
the Linux mascot Tux in it. The other three
images were of a cartoonish Easter Bunny.
These four images were produced in a manner
of seconds. Yes, I said seconds.

********************

Until next month, I bid you peace, happiness,
serenity, prosperity, and continued good health!

Screenshot ShowcaseScreenshot Showcase

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index! Posted by Archie, March 15, 2023, running KDE.

From The Chief Editor's Desk
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by David Pardue (kalwisti)

In this part 3 of the series, I’ll illustrate how to
add a keyboard layout, use the "Custom
Command" plugin, edit images and customize
your panel.

Add a Keyboard Layout

If you are bilingual – or just learning a new
language for fun – and need to switch back and
forth between languages, you will likely have to
change your keyboard layout.

I should clarify that changing to a foreign-
language keyboard layout will not automatically
change the language of the operating system.
For example, if you change to a Spanish
keyboard layout, the menus and system
messages will still be in English [assuming that
your current locale is set to American English].
In case you want to add a fully non-English
locale to your PCLinuxOS system, you may use
Pinoc's clever "addlocale" script. In LXQt, you
can access it under the System Tools menu >
Software Center > Localization Manager.
Complete instructions for using the addlocale
script are posted in the "Tips and Tricks" section
of the PCLinuxOS Forums.

These instructions cover how to add a foreign-
language keyboard layout in LXQt ver. 1.2.0. As

you will see, the procedure is straightforward.

First, right-click on the top panel > then choose
Manage Widgets.

Second, in the "Configure Panel" pop-up
dialog that appears, click on the " + " [plus]
button (right top).

Third, an "Add Plugins'' pop-up window
appears. Scroll down the list and choose the
"Keyboard State Indicator (kbindicator)"
widget. Then, click on the "Add Widget" button
to add it to your top panel (right).

Now, the Keyboard widget should appear at the
far-right end of the panel/taskbar (below).

Those three letters ("C N S") are called "Lock
Indicators", and their configuration will be
discussed at the end of this section.

Exploring LXQt: A Basic Guide, Part 3

https://www.pclinuxos.com/forum/index.php/topic,55229.0.html
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To move the Keyboard widget to a different
location on the panel, right-click on the widget
andchoose"ManageWidgets".

Highlight/choose the kbindicator widget by
clicking on it, then use the " ^ " [up] button to
incrementally move the Keyboard widget to
your desired location on the panel.

In the example below, I moved the Keyboard
widget to the left of the Volume widget.

Click on the "Close" button to close the
"Configure Panel" pop-up window.

Now, to add a new, foreign-language keyboard
layout, begin by right-clicking on the Keyboard
widget and choosing the option Configure
“Keyboard State Indicator”.

A "Keyboard state settings" pop-up dialog
appears. We will first click on the "Configure
layouts" button to add another language's
keyboard layout (right top).

(Note: For the moment, we will not
deactivate/de-select the three "Lock Indicators"
options in the top section of the dialog. Those
options cause the letters "C N S" to be displayed

beside the two-letter abbreviation of the active
keyboard layout).

Now, a "Keyboard Layout" pop-up window
will appear. To add a new language keyboard
layout, click on the "Add" button.

Exploring LXQt: A Basic Guide, Part 3
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When you select the “Add” button, a new pop-
up window will present an alphabetical list of
keyboard layout options to choose from.

In this example, I will choose a dedicated
Esperanto keyboard by highlighting it, then
clicking on the "OK" button.

The Esperanto layout will be added to the list of
installed keyboard layouts. If you wish, you
may also choose a key combination that allows
you to quickly switch between your installed

layouts. That key combination is selected from a
drop-down menu labeled "Keys to change
layout".

Clicking on that drop-down menu will display
available key combinations.

I decided on the "Win Key + Space"
combination. Click on the "Apply" button to
finalize your choice (right top).

Note: You are not required to select a layout-
switching key combination. If you prefer to

leave it set as "None", you can switch between
installed layouts by just clicking on the
Keyboard widget in the top panel.

Another area of personal preference involves the
three Lock Indicators ("Caps Lock Num Lock
Scroll Lock") in the kbindicator widget. To use
your taskbar space more efficiently, you can
toggle off the Lock Indicators by unchecking
(de-selecting) them in the "Keyboard state
settings'' pop-up dialog.

Exploring LXQt: A Basic Guide, Part 3
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If you toggle off the Lock Indicators display, the
kbindicator widget will look like this:

LXQt offers basic support for displaying
country flags instead of the two-letter language
codes. If you want to enable that option, right-
click on the Keyboard widget in the panel >
then select "Configure 'Keyboard State
Indicator'."

In the pop-up dialog that appears, look for the
"Flags path pattern" field and type the
following path into it: /usr/share/iso
flagpng/%1.png (that’s the number one
after the percentage sign).

The relevant country flags are located in the
/usr/share/iso-flag-png directory and the "%1"
will be replaced by the two-letter ISO country
code.

Click on the Close button. You should now see
the keyboard layout display with a flag (as
shown in the examples below with the US and
Spanish flags).

In case the flag file does not exist, or is an
image not easily shown, the Keyboard indicator
will fall back to the alphabetic ISO code (as
shown below with Esperanto).

If you prefer not to use flag icons, simply leave
the Flags path pattern field empty, and the
alphabetic ISO code will be displayed.

Try the "Custom Command" Panel Plugin

As of version 1.0.0 (released in November
2021), LXQt Panel has a new plugin, "Custom
Command" (customcommand), which displays
the output of a CLI command in your panel. If
you would like an idea of how to use this
feature, several bash command examples have
been collected on the "Discussions'' section of
LXQt's GitHub page.

This plugin can be installed in the usual way.
First, right-click on the panel. Next, choose the
"Manage Widgets" option. Then, in the
"Configuration Panel" pop-up dialog, click on
the "+" [plus] button. The "Add Plugins" pop-
up window will appear. Scroll down to the
"Custom Command" widget, and select it.

Now, click on the "Add Widget" button, then
on the "Close" button. The Custom Command
plugin will be added to the right-side edge of
your panel. To move the plugin to a different
location on your panel, right-click on the
widget, then select "Manage Widgets." Move
the plugin to your desired location by clicking
incrementally on the "^" [up] button in the
"Configure Panel" pop-up window.

When you have placed the plugin where you
want it, you can configure the plugin by right-
clicking on it and choosing "Configure

Exploring LXQt: A Basic Guide, Part 3
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'Custom Command'." Look for the
"Command" box and delete the placeholder
text (circled below in green):

Copy and paste one of the bash command
examples previously linked to on LXQt's
GitHub page. In the screenshot below, I have
used the command which shows the amount of
free disk space in my root partition (center top).

(Note: Although my root partition is on
/dev/sda2, I discovered through trial and error
that "sda2|awk [...]" did not produce any output.
In order for the command to work correctly, I
had to replace "sda2|awk [...]" with "root|awk
[...]").

Click on the "Close" button when you are
finished. The custom command above produced
the following result (center):

I also tried the bash command to monitor my
desktop PC's temperature (cat
/sys/class/thermal/thermal_zone0/temp |cut
-c1,2) which yielded the output below:

Similar Applets for Monitoring Your System

To be thorough, I will also mention four of
LXQt's native applets/panel plugins which can
provide helpful system information.

• CPU Monitor (cpuload): Displays the
current CPU load (as a graph).

• Network Monitor (networkmonitor):
Displays network status and activity.

• Sensors (sensors): Displays the output
from hardware sensors (as a simple graph).
The screenshot below shows the output from
my desktop PC's temperature sensors.
(Hovering your cursor over the widget will
cause it to display a tooltip text):

• System Statistics (sysstat): Displays a
graph for network or CPU activity, or
memory use. In the illustration below, you
can see how much memory is being utilized
(Hovering your cursor over the widget will
cause it to display a tooltip text):

Exploring LXQt: A Basic Guide, Part 3
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Edit Images with LXImage-Qt

I recently discovered two interesting features of
LXImage-Qt, the DE's native image viewer. The
application allows you to do bare-bones image
editing. Although its capabilities are more
limited than Shutter's edit mode, it can add these
simple annotations: arrow, rectangle, circle and
incrementing numbers.

Open an image file with LXImage-Qt, then go
to the View menu > and choose Annotations
Toolbar. The Annotations tools will appear at
the right edge of the toolbar (bottom).

LXImage-Qt lacks an Undo feature, so if you
make a mistake, you have to click on the
Reload File button (which will erase all your
edits/changes).

I experimented with the Annotations tools on a
photo (.jpg) and saved the results to give you a
demonstration of its editing capabilities. (The
only color option is red).

Another convenient feature of LXImage-Qt is
its ability to upload the currently open image to
an online service: Imgur, ImgBB or
ImageShack. This function works without
requiring you to log in to your personal account.

From the File menu > choose Upload. An
"Upload" pop-up dialog will appear. Select your
desired image hosting service from the drop-
down menu.

Click on the Start button. When the upload
finishes, the created URL will display in the
box. Click on the Copy button to share the link
with someone.

Customize Your Panel

In this final section, I will limit myself to an
overview because I do not usually spend much
time on customizing the appearance of my DE.
As with the topic of theming (discussed in my
previous article), this area is highly subjective
and "There are as many opinions as there are
people" – as the Roman playwright Terence
said. (Terence [Publius Terentius Afer, 185 - 159
B.C.] is credited with this observation in his
play Phormio (2.4). The original Latin quotation
is "Quot homines tot sententiae; suus cuique
mos" – 'There are as many opinions as there are
people: each has his own view').

Exploring LXQt: A Basic Guide, Part 3

http://www.linuxfoundation.org/
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The LXQt Panel can be customized quite a bit,
to suit your taste. To change your panel settings,
first right-click on an empty area of the panel,
then select Panel, and then Configure Panel.

A "Configure Panel" pop-up window will
appear.

Click on the "Placement" option in the left
margin of the pop-up window.

From here, you can change a variety of settings,
such as the size of the panel (Size), its length
(Length) and the icon size (Icon size).

In addition, you can change the panel's
alignment (Alignment) and its position on your
desktop (Position), i.e., whether you want it at
the top of your desktop, the bottom or on the
left. One characteristic of the Alignment setting
should be noted. Changing the alignment will
not have any effect if your panel occupies the
entire screen (i.e., if the Size > Length value
equals 100%).

If you wish, you can also enable the panel's
Auto-hide feature. (We will cover that in the
next subsection).

I should mention that there is no "correct"
answer to these configuration settings. Finding
the optimal setup depends on a combination of
factors in your workstation environment, e.g.,
the height of your chair, the height of your desk
and the height of your monitor(s). Linux is
highly customizable, so customize your DE
such that it is comfortable for you.

Daniel opted to have the default panel position
be "Top of desktop" for the LXQt 2022.11 .iso,
as well as for the 2023.01 .iso. This is a
reasonable decision which has the following
advantages:

•A well-placed monitor will cause you to look
at the top of its screen when you are looking
straight ahead. So your eyes will focus on the
upper part of the screen most of the time.

•Most applications have title bars and control
(Maximize, Minimize, Close) at the top of
their window. Thus mouse movement
primarily occurs in the top third of the screen.

• In Western societies, we scan (read) from top
left to bottom right, in a Z-pattern. The most
valuable spot on your screen is arguably the
top left corner.

While searching Linux forums for surveys
and/or opinions about panel placement, I found
that some users dislike a top panel because they
believe it increases the chance of misclicks, i.e.,
clicking on the wrong browser tab, mistakenly
clicking on a panel widget instead of accessing
the Close or Minimize button, etc.

Link to full-resolution screenshot:
http://pcloscloud.com/index.php/s/psHDwxyr2x
EjbjW

Exploring LXQt: A Basic Guide, Part 3

http://pcloscloud.com/index.php/s/psHDwxyr2xEjbjW
http://pcloscloud.com/index.php/s/psHDwxyr2xEjbjW
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If you prefer to have the panel located at the
bottom of your screen, choose Position:
Bottom of desktop.

Link to full-resolution screenshot:
http://pcloscloud.com/index.php/s/YgrKBgd2Nf
GFRBf

A bottom panel is a sound choice. That layout
has proven to be an efficient and functional UI
which feels natural to people who "grew up with
Microsoft Windows" and/or are new converts to
Linux. A desktop should be unobtrusive – and it
is most unobtrusive when it is familiar. I also
read comments pointing out that when you use a
laptop, the screen is usually below eye level.
Having a bottom panel means that it is out of
way and occupies less prime screen space.

Another option for panel placement which is
less commonly used is to have a vertical panel
on the left. You can accomplish this by selecting
the option Placement: Left of desktop (center
top).

Link to full-resolution screenshot:

http://pcloscloud.com/index.php/s/7Weq6Cc6Gi
a5pAw

I have tried this layout infrequently. However, it
is the default configuration of MX Linux's Xfce
Edition. It is also somewhat reminiscent of
Ubuntu's Unity environment (which I
experimented with in 2012).

The principal argument in favor of a left-side
panel is that it maximizes vertical space for
widescreen displays/monitors. The most
common option today for computer monitors --
as well as TVs -- is the widescreen aspect ratio
of 16:9. The "16" represents the top and bottom
of the screen while the "9" represents the sides.
So, the top and bottom are almost as twice as
long as the sides; a widescreen monitor looks
more like a rectangle than the square shape of
an "old-school" standard monitor (with a 4:3
aspect ratio).

With a widescreen display, therefore, vertical
space is more scarce than horizontal space.
Placing a vertical panel on the left edge will
sacrifice only a small amount of the screen's

abundant width, but none of the screen's limited
height.

Auto-Hiding the Panel

If you are hesitant to switch to a left-panel
arrangement but would like to make better use
of your widescreen monitor's vertical space, a
compromise solution is to auto-hide the bottom
(or top) panel. This will allow you to keep all
your vertical space.

Checking (ticking) the Auto-hide box will allow
you to select from among its various options.

• The Animation duration field changes how
long the animation takes to show (or hide)
the panel.

• The "Show with delay" field shows how
long (in milliseconds) your panel will appear
when it comes back after being hidden.

Exploring LXQt: A Basic Guide, Part 3

http://www.fsf.org
http://pcloscloud.com/index.php/s/7Weq6Cc6Gia5pAw
http://pcloscloud.com/index.php/s/YgrKBgd2NfGFRBf
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• The Visible thin margin for hidden panel
setting, when checked (ticked), will keep a
little bit of the panel visible when it is auto-
hidden (as shown below):

• The Hide only on overlapping a window
setting only hides the panel when it overlaps
a window.

• The Reserve space on display setting
configures the panel space so that it cannot
be used for anything else. It is recommended
to keep this option selected (active).

In conclusion, I hope these tips helped reduce
the learning curve and made you more
comfortable with LXQt, if you recently installed
it – or just took it for a spin with a Live USB or
VirtualBox session. LXQt is underrated, in my
opinion. It is one of the lightest mainstream DEs
and it boasts a classic desktop design updated
with modern features. Although the core
development team is small, they have
demonstrated a commitment to provide a solid
desktop environment for LXQt's growing user
base.

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS Magazine

Created with Scribus

Posted by bones113, February 28, 2023, running KDE.

Exploring LXQt: A Basic Guide, Part 3

http://www.scribus.net
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Yields: 4 Sandwiches

INGREDIENTS:

2 yellow onions, sliced
2 tablespoons butter
2 pinches Black Garlic Salt*
8 slices brioche bread, buttered
16 slices Cheddar cheese

DIRECTIONS:

Take a medium sized pan with a lid, on a
medium heat, add butter. Once butter has
melted, add the sliced onions, stirring to coat
with butter. Cover with a lid. Let onions steam
for about 5-8 minutes with lid on, stirring
occasionally. Once onions are translucent
remove the lid and add Black Garlic Salt. Keep
cooking onions on medium-low heat until
caramelized to desired color. If the onions get a
bit burnt it's OK to add a splash of water to stop
the burning - make sure to stir often.

Remove the onions from the heat and begin
assembling the grilled cheese. Using a cast iron
pan over medium low heat add slices of bread,
buttered side down, followed by two slices of
cheddar cheese. Over the cheese spread an even
layer of caramelized onions, and finish building
the grilled cheese by topping with the next slice
of bread, buttered side up. Let brown on each
side, about 3-5 minutes, until golden brown and
delicious.

* Where to buy Black Garlic Salt

https://jacobsensalt.com/collections/infused-sea-
salt/products/infused-black-garlic-salt

https://www.amazon.com/Trader-Joes-Ground-
Fermented-
Garlic/dp/B08VW1MVHF/ref=sr_1_16?crid=Y
SF6L04WFF81&keywords=black+garlic+salt&
qid=1672718165&sprefix=black+garlic+salt%2
Caps%2C180&sr=8-16

TIPS:

Dip your sandwich in mustard for an extra little
kick. Enjoy!

NUTRITION:

Calories: 323 Carbs: 35.5g Fiber: 1g
Sodium: 174mg Protein: 14.6g

Linux Docs
Linux Man Pages

PCLinuxOS Recipe Corner

Caramelized Onion Grilled Cheese
Turn this simple, comfort food, into an elevated, and delicious meal.

http://www.die.net/
https://jacobsensalt.com/collections/infused-sea-salt/products/infused-black-garlic-salt
https://www.amazon.com/Trader-Joes-Ground-Fermented-Garlic/dp/B08VW1MVHF/ref=sr_1_16?crid=YSF6L04WFF81&keywords=black+garlic+salt&qid=1672718165&sprefix=black+garlic+salt%2Caps%2C180&sr=8-16
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users.
The PCLinuxOS Magazine accepts no responsibility for the content, accuracy,
conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with respect to
the subject matter hereof and supersedes and replaces all prior or
contemporaneous understandings or agreements, written or oral, regarding such
subject matter.

Disclaimer

Posted by monbureaulinux, March 10, 2023, running KDE.

http://www.pclosusers.com/services-signup.php
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by Paul Arnote (parnote)

Most of the time, the sage advice around the PCLinuxOS forum is to NOT
install software from outside of the official PCLinuxOS repository. It’s a
trivial task to run into what is dis-affectionately called “dependency hell.”
You also lack a full listing of changes made to your system, so installing
even one “unofficial” piece of software could break 10 other working
programs, or even render your installation unusable (or even unbootable).

If things do “go South” for your installation, good luck trying to figure out
exactly what went wrong, since you have no idea what changes were made
to your system. Plus, unless you install software from a trusted source, you
could unknowingly install malware, spyware, viruses, ransomware,
cryptomining software, credential stealing software, etc. Sometimes, it can
be difficult to know exactly who to trust.

BUT … most of that advice formulated years ago, before the introduction
of self-contained, sandboxed, ready-to-run software packages that don’t
make those potentially disastrous system-wide changes to your computer.

Today, these self-contained, sandboxed, ready-to-run software packages
are typically just fine to install and use on your PCLinuxOS installation,
with only a few minor, but vital, caveats. Keep your guard up for these
caveats, and the use of these outside packages shouldn’t pose much of an
issue for you. As with most things, it’s usually when we let our guard
down that disaster strikes.

There are three such software package formats available for Linux users.
One of them, snaps, won’t be covered here. Snaps require the use of
systemd, and PCLinuxOS is proud to be systemd-free. So, that makes snap
packages an immediate “no go” for PCLinuxOS users. Snap packages,
which can be easily distinguished by their .snap file extensions, originated
with the *buntus, which do use systemd. Introduced in 2016 by Ubuntu,

snap packages are available from Canonical’s Snap Store. There are other
outlets for snaps, but users should be cautious and vet the source of those
snaps to be sure they can be trusted. Today, most Linux distributions that
support systemd also support snaps.

The other two self-contained software packages for Linux users are
AppImage and Flatpak. These two formats CAN be used by PCLinuxOS
users, provided you heed the caveats and exercise caution. We’ll cover
each one of these package formats separately, so that we can do each
justice.

Interestingly, while writing this article, I found several mentions of a
“movement” to move away from snap to Flapak among *buntu users. Only
time will tell if their efforts pay off, or if those efforts are in vain.

Wait! Here Are The Caveats!

So, as with just about anything these days, there are some things that you
need to be on the lookout for when installing software from outside the
official PCLinuxOS repository.

First, be sure you can trust the source of the package. Don’t revert to
being a “Windows user” and just install things willy-nilly. Vet the source
of the package, to help ensure that it isn’t going to harm you, your data, or
your computer. There are monitored and vetted online repositories for both
AppImage and Flatpak packages. Items used from these sources should be
able to be trusted.

Second, research the program you are wanting to install. You will want
to be sure that the program you are wanting to install will do what you
want it to. You will also want to be sure it isn’t going to harm your
computer or your data. Be suspicious of AppImage and Flatpak packages
that aren’t in one of the “official” (defacto?) online repositories.

Expanded Choices: AppImage & Flatpak Packages
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Third, if you’re an “advanced” user, you can examine the program’s
source code for anything suspicious. That isn’t always practical, however,
depending on the size of the source code. A self-contained package for
GIMP or AbiWord is going to contain thousands of lines of code, separated
into a bajillion different modules. I don’t know about you, but I’ve
forgotten a LOT of my C coding knowledge (use it or lose it), and I’m
totally lost when it comes to C++ (that stuff never made sense to me). And
even then, a skilled programmer can find ways to camouflage malicious
code to all but the most skilled of programmers.

Fourth, don’t expect every AppImage or Flatpak you find to run on
PCLinuxOS. It’s not going to happen. Some programs are going to require
systemd to communicate with subsystems on your computer, and since
PCLinuxOS is systemd-free, those subsystems will most likely fail. To
expect every AppImage or Flatpak to run perfectly and successfully
manage communications with those subsystems is too high of a bar to set.
You may occasionally find an AppImage or Flatpak that works perfectly,
but that would be the exception, and not the rule. You need to be prepared
to find workarounds to the things that don’t necessarily work well. In some
cases, there may not be a workaround. The thing you’ll need to figure out
is if the program performs most of the task you need it to perform. Then,
that makes the workarounds easier to deal with. I’ll talk more about this
(as in providing specific examples) when we talk about each package
format.

When it comes down to it, if the program you want is already in the
PCLinuxOS repository, your best bet is to use the package from the
official PCLinuxOS repository. Those packages can be trusted 100%, and
sometimes, our packagers tweak those programs with the latest patches
and other enhancements. And, while the official repository contains a LOT
of programs to install on your computer running PCLinuxOS, there may
occasionally be an instance where you need to run a program that hasn’t

already been packaged by our dedicated PCLinuxOS packaging crew. For
those times, your second best bet is to use either an AppImage or a Flatpak
of that program.

AppImage

Back on November 20, 2022, PCLinuxOS forum moderator Archie started
a post in the forum about using AppImage to add programs to your
computer. Included in that forum thread, Archie also compiled a list of
AppImages that have been reported to run on PCLinuxOS. (Parts of this
section of the article are excerpted from his post.)
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Here’s how Wikipedia “defines”AppImages:

AppImage aims to be an application deployment system for Linux with the
following objectives: simplicity, binary compatibility, distro agnosticism,
no installation, no root permission, being portable, and keeping the
underlying operating system untouched.

You can read the full Wikipedia entry for AppImages here.

Below is the list that Archie compiled. Items in bold text are already in the
official PCLinuxOS repository, and the list is current as of the writing of
this article (the middle of March, 2023). Refer back to the original forum
thread for periodic updates of the list.

The following are AppImages that work on PCLinuxOS (at least on my
(Archie’s) install and other contributors). Bold indicates the apps are also
in our repo and installable (but not as AppImage).

Disclaimer: Use at your own risk. The AppImages are not supported in the
forum, except the ones created by our packagers.

* audacity-linux-3.2.1-x64.AppImage (43.1 MiB) - software that enables
the users to both record and edit audio clips.

* BilibiliVideoDownload-3.3.3.AppImage (113.2MiB) - a free tool to help
you download high quality Bilibili video URLs in MP4, M4A and MP3
formats.

* Buttercup-linux-x86_64.AppImage (85 MB) - a free, open-source and
cross-platform password manager, built on NodeJS with Typescript.

* Colon-1.4.4-x86_64.AppImage (53.7 MB) - a flexible text editor, built
on Electron, and based on everything we love about our favorite editors.

* Ferdi-5.8.1.AppImage (135 MB) - a desktop app that helps you organize
how you use your favorite apps by combining them into one application.

* FreeCAD_0.20-1-2022-08-20-conda-Linux-x86_64-py310.AppImage
(911 MiB) - an open-source parametric 3D modeler made primarily to
design real-life objects of any size.

* GoldenDict-3aaaf15-x86_64.AppImage (55.16 MiB) - a feature-rich
dictionary lookup program.

* Inkscape-9c6d41e-x86_64.AppImage (121.6 MiB) - a free and open
source vector graphics editor.

* Knowte-2.0.9.AppImage (102 MB) - a note taking application that
allows you to quickly and easily organize and find your notes.

* LibreCAD-2.2.0-rc4-23-ge3fae3dc-x86_64.AppImage (46.5 MB)- a 2D
CAD drawing tool based on the community edition of QCAD.

* LibreOffice - a portable version of LibreOffice for Linux that can be run
from any location (e.g. local drive, USB, CD, network share) on all
popular Linux distributions, including live CDs. LibreOffice AppImage is
available in three versions - Basic (264.2 MiB), Standard (310 MB), and
Full (421 MB) - which support a different set of languages.

* Mapton.AppImage (v2.2.1) (173 MB) - a map application.

* Motrix-1.6.11.AppImage (84.4 MB) - a full-featured download manager
that supports downloading HTTP, FTP, BitTorrent, Magnet, etc.

* MKVToolNix_GUI-72.0.0-x86_64.AppImage (49.9 MiB) - a GUI for
mkvmerge.

* Nextcloud-3.3.6-x86_64.AppImage (101.6 MiB) - a file-sharing and
collaboration app for organizing personal cloud storage.

* OpenTodoList-3.42.0-x86_64.AppImage (52.2 MB) - a todo list and note
taking application. Organize todo lists, notes and images in libraries,
which can be stored either completely local on the device you are working
on (and hence ensure no information leaks out to untrusted third parties) or
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use the built in synchronization features which allows you to synchronize
your libraries across devices using your self-hosted NextCloud or
ownCloud server (or other WebDAV servers).

* Passky-7.1.0.AppImage (86.4 MB) - a simple, modern, lightweight, open
source and secure password manager.

* PeaZip-v8.9.0-x86_64.AppImage (12.5 MB) - a free file archiver utility,
based on Open Source technologies.

* Photopea_1.2.1_x86_64.AppImage (73.3 MB) - This is a simple
AppImage for Photopea. It was made in Electron and then built as an
AppImage. It works exactly like the browser version does.

* PhotoQt-2.9.1.AppImage (48.8 MiB) - a simple open source image
viewer.

* PyCharm_Community_Edition.2022.2.2-x86_64.AppImage (451 MB) -
designed by (JetBrains) programmers, for programmers, to provide all the
tools you need for productive Python development. Great app for learning
Python!

* qBittorrent-Enhanced-Edition-x86_64.AppImage (22.7 MiB) - a free
and open source BitTorrent client.

* qpdfview-0.4.18-x86_64.AppImage (37.8 MiB) - darealshinji's personal
Github mirror of the qpdfview source code.

* shotcut-linux-x86_64-221025.AppImage (116.6 MiB) - a free, open
source, cross-platform video editor.

* subtitlecomposer-latest-x86_64.AppImage (57.2 MiB) - an open source
text-based subtitle editor.

* Tencent-QQMusic-v1.1.4-x86_64.AppImage (81.8 MiB) - one of three
Chinese freemium streaming services owned by Tencent Music.

* Tencent-WemeetApp-v3.9.0.1-x86_64.AppImage (215.4 MiB) - a cloud-
based HD conferencing product leveraging Tencent's 20+ years of
experience in audiovisual communications.

* webamp-desktop-0.3.0-x86_64.AppImage (50.1 MB) - Unofficial app. A
cross-platform (Win, Mac, Linux) desktop version of Winamp 2.9
reimplementation.

* Zoom-5.12.6.173.glibc2.17-x86_64.AppImage (177.3 MiB) - AppImage
for the Zoom desktop application (until Zoom provides an official one).

From Codalunga:

* Bitwarden-2022.10.1-x86_64.AppImage (87.21 MB) - The best
password manager around according to privacytools.io.

* xournalpp-1.1.2-x86_64.AppImage (31.3 MB) - A note-taking and
handwriting software with PDF annotation support.

* Upscayl-1.5.5.AppImage (164 MiB) - AI image upscaler built with
Linux-first philosophy.

From daniel:

* QMPlay2-22.10.23-1-x86_64.AppImage (28.5 MB) - a video and audio
player. It can play all formats supported by FFmpeg, libmodplug
(including J2B and SFX). It also supports Audio CD, raw files, Rayman 2
music and chiptunes. It contains YouTube and MyFreeMP3 browser.

From kalwisti:

* Eqonomize-1.5.3 (27.6 MiB) - a cross-platform personal accounting
software, with focus on efficiency and ease of use for small households.
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From reelcat

* DownZemAll_v2.5.8_x86_64_no_launcher.AppImage (25MB) - a
standalone download manager and rewrite of the legacy software
DownThemAll! which was an extension for Mozilla Firefox, but whose
development stopped around 2016, when Mozilla Firefox migrated to
WebExtensions.

* linux_czkawka_gui.AppImage (5.15 MB) - (tch•kav•ka (IPA: [ʈ ͡ʂkafka]),
"hiccup" in Polish) is a simple, fast and free app to remove unnecessary
files from your computer.

From RPsx94:

* tutanota-desktop-linux.AppImage (95.5 MB) - the world's most secure
email service, easy to use and private by design.

From Stingray:

* friture-0.49-20220316.AppImage (88.7 MB) - an application to
visualize and analyze live audio data in real-time (live spectrum analyzer).

* SonicVisualiser-4.5.1-x86_64.AppImage (39.3 MB) - a program for
viewing and analyzing the contents of music audio files (spectrum
analyzer for audio files).

And a few more untested AppImage that I believe are current versions. If
anyone can help test them, I could bump them up to AppImages that
works on PCLinuxOS and delete them from this section list.

* AnyDesk-6.1.0-1-x86_64.AppImage (10.3 MB) - (Note: our repo
version is 6.2.1) an easy-to-use remote desktop software that includes all
basic features that are free for personal use.

* bforartists-v3.3.1-x86_64.AppImage (366 MB) - a fork of the popular
open source 3D software Blender. It is a complete, free and open source
3D suite to create CG content.

* Database.Dossier.v1.0.0.AppImage (307 MB) - a free database user
interface program, you can use it for browsing and querying your
databases. At present it can be used for accessing MariaDB and MySql
database servers.

* SuperTuxKart-1.4-x86_64.AppImage (633 MB) - Unofficial AppImage
of SuperTuxKart built from the official release.

* Telegram_Desktop-x86_64.AppImage (49.5 MB) - a cloud-based
mobile and desktop messaging app with a focus on security and speed.

* YTDownloader.AppImage (128 MB) - modern GUI video and audio
downloader supporting hundreds of sites.

* Viper_Browser-1-x86_64.AppImage (129 MB) - a powerful yet
lightweight web browser built with the Qt framework.
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Installing AppImage files is as easy as making them executable ($ chmod
a+x appname.AppImage). Or, if you prefer a graphical approach, right
click on the AppImage file in your graphical file manager, select
“Properties” from the context menu, click on the “Permissions” tab, and
check the box labeled “Allow this file to run as a program” (or some such
similar wording). There is nothing extra or special that you have to install
from Synaptic to be able to install and use AppImage packages.

You can “install” AppImage files anywhere on your system, even in your
own /home directory. If you want the AppImage available to all users of
your computer, move the AppImage file to your /usr/bin directory (you

will have to do this as the root user). Otherwise, if you “install” the
AppImage from a location in your /home directory (I have a subdirectory
under my Downloads directory, called AppImages, naturally), it will only
be available to you (or the owner of that particular /home directory).

If you think you want to “uninstall” the package, it is as simple as deleting
the AppImage file. Some AppImages will actually create their own
.desktop file, but most rely on the user to create the .desktop file so they
can appear in the menu.

Now that you know what to do with the AppImage files, it’s time to learn
where to obtain them. There are a few decent AppImage “repositories”
available that you should be able to trust. The first one is AppImage Hub,
and it has 1,232 AppImage files for you to browse. Next, there is Area of
Dev’s collection on GitHub. There is an even larger collection of
AppImage files on GitHub, and it contains 1,368 AppImages, sorted
alphabetically. Finally, Awesome Open Source has a collection of
AppImages.

I’m sure you can find other sources for AppImage files. Just be certain to
keep your guard up, and to vet your source to be certain that you are not
unwittingly or unknowingly installing some malware.
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Flatpak

Flatpak packages are the “other” self-contained software distribution and
installation file format. According to Wikipedia, Flatpak “is a utility for
software deployment and package management for Linux. It is advertised
as offering a sandbox environment in which users can run application
software in isolation from the rest of the system.”

While the end result is virtually the same – installing programs to run on
your computer – Flatpaks work a little differently. To install and use
Flatpaks on PCLinuxOS, you will need to first install the flatpak utility via
Synaptic and the PCLinuxOS official repository. AppImages can be
downloaded and left in any directory of your choosing, and be run from
that location. Flatpaks, on the other hand, have to be installed via the

flatpak command line utility, and they are installed system-wide, for all
users.

While this sounds a little more complicated, the flatpak command line
utility makes it very, very easy to manage the Flatpaks installed on your
computer. If you’re a GUI user who typically shies away from using the
command line, don’t. You could be missing out on quite a lucrative and
rich resource.

To start using Flatpaks on your computer, head on over to Flathub.org. It
has become the defacto (albeit unofficial) go-to repository for Flatpak
files. At the time of this article’s writing (mid-March 2023), there are
2,027 Flatpak files available for you to choose from on Flathub.org. If you
search for them, you can also find quite a few Flatpak files available on
GitHub. If you download from GitHub, exercise caution and keep the
caveats I mentioned previously in mind. From my brief visit to GitHub to
see what was offered there in the way of Flatpak files, most of what I
found also already existed on Flathub.org. You may also find some Flatpak
files on BitBucket.

I’ll use the Dave Gnukem game Flatpak to illustrate what you need to do
on the flathub.org website. At the top of the screen, you will see the
“Install” button. Click it, and the com.djoffe.gnukem.flatpakref file will be
offered up for download to your computer. Save this file in a directory
where you want to keep your Flatpak files. I keep those files in my
Downloads/flatpak directory of my /home directory.

At the bottom of the flathub.org page for Dave Gnukem (you’ll have to
scroll down), you’ll find “Command line instructions” for the Flatpak you
are wanting to install. Click on the “Copy” icon (red arrow) to copy the
command to your clipboard. For what it’s worth, I’ve **never** had to
use the second command. In every instance where I installed a Flatpak, the
program was properly added to my PC “start” menu, in the proper
category. I suppose that the “Run” command might come in handy if I
wanted to start the program from the command line, or if I wanted to
create a launcher on my desktop or on my panel.
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For the rest of the images showing how to install a Flatpak file, I’ve
switched to a screen capture of two actual Flatpaks that I’ve installed. In
this case, it’s A Photo Tool (Libre) and PDF Edit. I’m not much of a gamer
(I don’t have time for it), so Dave Gnukem is going to have to yield to this
graphics tool and PDF utility that will have much more use for me.

Installing A Photo Tool (Libre)

Installing PDF Edit

Now, open a terminal session, and as a normal user, cd to the directory
where you stored the flatpakref file you downloaded from flathub.org.
Now, paste the command you copied to your clipboard in on the awaiting
command line prompt. Hit enter, and follow the prompts. When asked to
do so, enter your root password in the dialog box that’s presented. Don’t
worry. You should recognize it easily. It’s the same dialog box that you see
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when you run updates on your computer using Synaptic (or any other time
you are asked for your root password).

Now, sit back and wait for the components of the Flatpak file to be
downloaded and installed on your computer. It won’t take long, depending
on the size of the program you’re installing and the speed of your internet
connection. You *might* have time to go get a cold soda pop or a glass of
water.

If everything went well, then you should now see your new program that
was installed from the Flatpak file now appears in your PC “start” menu,
as indicated above for A Photo Tool (Libre). Despite only having installed
three Flatpak files myself, I have yet to find an instance where the program
I install doesn’t appear in my PC menu. And, that is the reason I have yet
to use the “Run” command listed on the flathub.org website. Instead, I just
go to my PC menu, and select the program’s entry there to run it.

If you want to see all of the Flatpak packages installed on your system, all
you have to do is type flatpak list at the command line.

Flatpak files also “uninstall” a bit differently from AppImage files.
Whereas all you have to do with AppImage files is simply delete them,
Flatpak files require you to use the flatpak command line tool to uninstall.
The format is simple. Type flatpak uninstall [name-of-flatpak-file] at a
command line prompt, and the program will be uninstalled from your
computer. Replace “[name-of-flatpak-file]” with the name of the Flatpak
file you downloaded from flathub.org, minus the “flatpakref” file
extension.

BBee ssuurree ttoo cchheecckk oouutt
AAlleessssaannddrroo''ss GGaammee ZZoonnee rreevviieeww
ooff DDaavvee GGnnuukkeemm,, iinnssttaalllleedd ffrroomm
FFllaattppaakk,, eellsseewwhheerree iinn tthhiiss iissssuuee..
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Summary

We all know, love and appreciate how responsive Texstar and his merry
band of packagers are at getting the things we need or want into the
official PCLinuxOS repository. But, there’s a limit to what this small band
of excellent packagers can do. AppImage and Flatpak files give you
another option, besides relying on just the offerings in the official
PCLinuxOS repository.

As long as you keep the “caveats” listed towards the beginning of this
article in mind, you can expand your Linux software horizons considerably
… and safely. Meanwhile, if you find an AppImage or Flatpak that runs
well on PCLinuxOS, send Archie a PM on the forum with the information,
or add it to the forum thread. I’m sure that there are other PCLinuxOS
users who might like to know.
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by Alessandro Ebersol (Agent Smith)

Duke Nukem, the father of Dave Gnukem

Who doesn't remember the classic 1991 Apogee
Software game that brought the hero Duke
Nukem to the world? Yes, Duke Nukem started
out as a 2D platform game.

Duke Nukem 1 was a famous original 16-color
320x200 'classic' game released by Apogee
Software in 1991 that launched the Duke
Nukem series. The original Duke Nukem 1 was
created by Todd Replogle (co-creator of the
Duke Nukem series), John Carmack (of id
Software), Scott Miller (founder of 3D Realms),
Allen H. Blum III, George Broussard, and Jim
Norwood.

The game is set in 1997. Dr. Proton, a mad
scientist, determined to take over the world with
his army of Techbots.

Duke Nukem must then go through various
stages, always looking for items to be able to
unlock the exit of the stages, and go to the next
stage.

In addition to points, some collectibles include
health powerups, weapon powerups, and some
inventory items with special abilities. The final
level of each episode has no exit, and instead is
completed by discovering and defeating Dr.
Proton.

In 1995, Flux magazine ranked the game 39th
on its list of the 100 best videogames: "Without
a doubt, the best platform game for the pc ever
created.”

Enter Dave Gnukem!

Since Duke Nukem was such a beloved title by
fans, there was a cooperative effort to bring it
back to life.

The project was originally created and
maintained by David Joffe (~1994 to 2004, and,
from October 2016 to the present). It was
maintained by EMH (Evil Mr Henry) from 2004
to 2008. Additional contributions came from
T.O.G., Vytautas Shaltenis, Kent Mein, Steve
Merrifield, Felix Richter, Kevin Joffe. Matteo
Bini and Craig Langman.

As of October 8, 2016, this project is again in
active development, and on April 3, 2018,
version 1.0 was released.

Game Zone: Dave Gnukem

http://www.linuxforums.org/forum/
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Game Plot

The year is $CURRENTYEAR+8. An evil
genius, Dr. Proetton, has been hired by the CIA
to infect the world's computers with a virus
called SystemD, paralyzing them. Only you can
stop him. You must find the diskette with
Devuan Antivirus on it, and install it on the
main computer, which is hidden in Vault7.

Any resemblance to real persons or entities is
purely coincidental.

Actually Dave Gnukem could also be equipped
with PCLinuxOS ISO's, which are also effective
against SystemD infection.

Review

The game is a clone/remake/homage to the
original Duke Nukem, and is very close to the
original.

In fact, the nostalgia is strong with Dave
Gnukem, to the point of having video modes,
which mimic the original EGA and CGA video.

Commands

Default keys:

• Left/Right: Move left/right
• Ctrl: Jump
•Alt: Shoot
• Up arrow: Action key (e.g. open doors, use

teleporters or elevators, activate
exit, etc.)

• Escape: In-game menu
• 7/6: Increase/decrease volume
• Insert: Turn sounds on/off
• Shift+F6/F7: Speed +/- (framerate)
• Shift+F8/F9: Turn on/off map and sprite auto-

shadows respectively
• F10 Save screenshot

To open doors, find the correct colored key and
press the action key on the ''lock'' next to the
door(s).

Power boots allow you to jump higher. The
special molecule collection gives you full
health.

Gameplay

Well, to write this article, I installed and played
it, and it was very good. The game is spot-on in
nostalgia, and brings the old Duke Nukem to the
present day and to today's hardware.

One down side was the lack of joystick support,
but it can be circumvented with Antimicro (joy-
to-key emulator).

Other than that, it is an excellent game and a
great pastime.

How To Install

To install, you must first have Flatpak installed.

Then open a terminal and type:

Game Zone: Dave Gnukem
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Then flatpak will work and download all the
game dependencies.

To play, in a terminal type: flatpak run
com.djoffe.gnukem

I am not a big fan of flatpak packages. In this
case, a simple game like this, that in the worst
case would take 22 MB of disk space. However,
with all flatpak dependencies installed, it took
557 MB's of disk space, which for a simple
game, is too high.

But, it is a fun game and a good time killer.

I hope you enjoyed it (I enjoyed trying Dave
Gnukem), a big hug and see you in the next
article.

Screenshot ShowcaseScreenshot Showcase
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by Meemaw

Again, watching YouTube for graphics tips, I
came across a video on the channel Logos by
Nick where he shows us how to make a simple
line art logo using some of the Path tools. His
was a mountain, trees and water with the sun
behind it, and it was really good!

I decided to go a different direction, so I used a
trace I made of tuxlink’s awesome Dobie from
the wallpaper he gave us recently, and made
something sort of similar. When you set up your
page, make sure the setting “Scale Stroke
Width” is turned off. That way, when you make
your stroke width 5 pixels, and then resize
something, the pixel width will stay 5, making
things uniform. It’s much easier than going to
Fill & Stroke and changing it with every line.
Also, remember to use the command Path >
Object to path on the objects that you draw,
since we’re using path commands.

I started with the tracing of Dobie and drew a
circle around it. I set my pixel width at 5 as well
(center top).

In my design I added lines so it sorta looks like
there’s a bit of floor under him. I made them a
little long, so I’m going to fix that soon. The
first thing I’m going to do is space the lines the
same distance apart. Select them all, then using

Align & Distribute, choose the vertical
distribution.

Since you have your lines chosen, go to Path >
Combine (<CTRL> + K) and combine them
together. That way, when you move them,

they’ll all move together and not slip out of
alignment while you are moving them. I had
already drawn mine over the circle, so they were
where I wanted them. I also planned the top and
bottom lines to be in a certain spot, and drew the
other two in between, then aligned and
combined.

Also remember that while you are dragging a
duplicate, and need another, you can just hit
your spacebar.

Now I have this:

I’ve decided I want my lines ONLY inside the
circle. I could mess with them, trying to get
them reduced in size, but there is an easy
method, since they need to end up all different
lengths. I’m going to duplicate the circle,
choose the lines, then the new circle, and then

Inkscape Tutorial: Line Art Designs

https://www.youtube.com/watch?v=NeZ9XZZYYdw
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go to Path > Cut path (<CTRL> + <ALT> +
/). This cuts the lines where the circle intersects,
and I can move the lines and delete them.

I plan to put some text at the top of my circle
(PCLinuxOS), but I’m going to cut part of the
circle out to emphasize the text. I’ll use the
same method that I used on the lines. I drew an
object over the top of the circle, selected it and
the circle, and did a Path > Cut path (<CTRL>
+ <ALT> + /).

I deleted that section.

Now for the text. I had always planned to have
another circle inside the first, so I drew it the
same distance from the outer circle as the lines
are apart. I edited my text, changing the font and
size to my liking. (I did have to change the font
so it had black fill and no stroke.) Choosing the
text and the circle, I chose Text > Put on path
(top right).

Well, that’s strange… that’s not at all where I
wanted that text! However, instead of trying to
move the text, select the circle and rotate it until
the text is in the right spot. Then I de-selected
everything and re-selected the text, and moved it
away from the inner circle (right).

You might add to this if it was yours, but I think
I’m finished. This is a pretty simple line art
design that might look good on a t-shirt or
something like that. Hope you have some fun!

Inkscape Tutorial: Line Art Designs
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by CgBoy

Buttercup Password Manager is a modern and
feature-rich open source password manager that
was recently added to the PCLinuxOS
repositories. Featuring 256 bit AES encrypted
vaults, Buttercup provides a high level of
security for your passwords and other sensitive
information. In addition to the desktop program,
mobile versions are available for iOS and
Android, along with browser extensions for
Firefox and Google Chrome.

The user interface has a polished, well designed
look to it, making Buttercup Password Manager
very easy to navigate and use. Each vault opens
up in a separate tab, allowing you to easily
switch between them. Creating a new vault is as
simple as clicking on the + button in the upper
toolbar.

When you create a new vault, you are first given
the choice of where you want it to be located.
You can store vaults locally on your computer,
or use one of the cloud storage services offered
(Dropbox, Google Drive, or WebDAV). Then
you need to provide a master password to be
used for accessing the vault, and simply hit Add
Vault. Buttercup also has the ability to import
data from other popular password managers,
including Bitwarden, KeePass, Lastpass, and
1Password. Buttercup automatically locks the
vaults whenever you quit the program, keeping
your information safe from any prying eyes.

On the left side panel, you can choose and
create new groups to help you organize your
documents better. From the middle of the
screen, you can select and sort the documents
(password entries) in the vault, and then view
them from the right side panel. Go ahead and
click on New Entry to start adding passwords
into the program. Buttercup gives you several

template options for creating new documents,
such as for normal login details, bank card
information, SSH keys, and even just plain
notes.

Buttercup includes a built-in password generator
with many different options, which can be
accessed by clicking the button next to the
password fields. You can also add your own
custom text fields to documents if you need to
do so, and even attach files to be encrypted
along with the document.

Repo Review: Buttercup Password Manager
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Buttercup has in-development support for
fingerprint reader unlocking, but unfortunately
at the moment this feature is grayed-out as it
currently only works in macOS. From the
preferences, you can set Buttercup to clear the
clipboard contents, or lock all vaults after a
certain set time period for extra security.
Buttercup also provides a handy icon down in
the taskbar for quick access when the program is
minimized.

Summary

I was very impressed with Buttercup Password
Manager during my testing, and it compares
well to other options, such as Bitwarden. You
can tell, though, that some features are still
being developed, and there is not a whole lot of
documentation available yet. But on the whole,
I’d say that Buttercup is one of the best free and
open source password managers that I’ve used,
and thankfully requires no account or anything
to set up.

Help PCLinuxOS Thrive & Survive

DONATE
TODAY
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by Paul Arnote (parnote)

Have you noticed that the picture quality has been diminishing at your
local movie theater? Well, you’re not alone. An article on Vulture points to
how bad projection is ruining the movie theater experience, and
multiplexes are failing at their most basic function: delivering a bright,
sharp image

Might medical researchers have discovered the proverbial fountain of
youth? The National Geographic website takes a look at senolytics in their
article about the groundbreaking promise of ‘cellular housekeeping.’
What if, as you aged, you could make your heart as good as new? Your
brain? Every other part of your body that ages? That’s the promise of what
lies ahead with one of the major players in the quest for longevity:
senolytics.

LastPass attacks began with a hacked employee's home computer. The
investigation now reveals the password manager company's data vault
was compromised, according to an article on TechRepublic. The
password manager’s company has released two security bulletins, one
for LastPass users and another one for business administrators. Hopefully,
most of you reading this were like me, and ditched LastPass altogether
after they severely limited the “free accounts,” which included deleting all
of my data from LastPass and porting everything over to BitWarden. We
covered the move from LastPass to BitWarden, as well as the whole
LastPass money-grab, in the April 2021 issue of The PCLinuxOS
Magazine.

The discovery of giant superclusters of galaxies, known as the Giant
Arc, are challenging our very understanding of the Universe, according
to an article on BBC Future.

Get your telescopes tuned up (don’t worry… you have time)! Make a note
of the newly discovered comet with the lengthy name of C/2023 A3
(Tsuchinshan-ATLAS) as it gets closer to the Sun and our planet, it could
shine brighter in Earth's night sky than many stars, according to an
article on ScienceAlert. The comet's nearest approach to the Sun, or
perihelion, won't be until September 28, 2024, before hitting its closest
point to Earth a few weeks later on October 13, so you've got plenty of
time to get your blanket and telescopes organized. Though estimates are
extremely tentative, astronomers are predicting a brightness of magnitude
0.7 at the comet's perihelion. At its closest point to Earth, the comet's
magnitude could reach an even more dazzling -0.2, which would make it
one of the brightest objects in the night sky. Add in the effects of forward
scattering, where the dust and ice of the comet reflects the light from the
Sun, and we might even reach a -5 magnitude.

I love just about any topic dealing with WWII. There’s a fascinating story
about members of the German Wehrmacht (the German “regular”
army), some American G.I.’s, and some French POW’s fighting side-
by-side against a 150 man force of the German Waffen-SS (the infamous
“death squads”) in the Battle of Castle Itter in Tyrol, Austria during the last
days of WWII (just two days before Germany signed the articles of
unconditional surrender) on the EL PAÍS website.

The place where breaking news,
BitTorrent and copyright collide

ICYMI: LastPass Data Breach Post Mortem
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Ba-da-boomp-boomp-boomp… another Google service bites the dust.
As if right on cue, the Google service known as Grasshopper is scheduled
to be eliminated by year’s end, according to an article on Android Police.
Grasshopper was Google’s app to help teach users how to write
programming code. It was started in 2018 to help teach structured
programming (using JAVA) to interested users. If you’re interested, you
can view the ongoing tally of services axed by Google here (yes, it’s a
whole website devoted to the Google body count).

A new malware dubbed HiatusRAT infects routers to spy on its
targets, mostly in Europe and in the U.S., according to an article on
TechRepublic. Lumen’s Black Lotus Labs has exposed new malware
targeting routers in a campaign named Hiatus by the researchers. The
Hiatus campaign primarily targets DrayTek Vigor router models 2960 and
3900, which run an i386 architecture. These routers are mostly used by
medium-size companies, as the router capabilities support a few hundred
of employees’VPN connections.

By exploiting webcams and other IoT devices, hackers can spy on
private and professional conversations, potentially giving them access
to sensitive information, according to an article on TechRepublic. In a
new report about insecure IoT devices, BitSight discovered that one in 12
organizations with internet-facing webcams or similar devices failed to
properly secure them, leaving them vulnerable to video or audio
compromise.

Mandiant, working in partnership with SonicWall Product Security and
Incident Response Team (PSIRT), has identified a suspected Chinese
campaign that involves maintaining long term persistence by running
malware on an unpatched SonicWall Secure Mobile Access (SMA)
appliance, according to a blog post by Mandiant. The malware has

functionality to steal user credentials, provide shell access, and persist
through firmware upgrades.

Might researchers have finally started to narrow in on things that cause
age-related decline? Supplementing the amino acid D-serine helped to
mitigate some of the age-related changes associated with a decline of
the hypothalamic hormone Menin in mouse models, according to an
article on Neuroscience News.

A higher density of food stores carrying less healthy options is
associated with a higher prevalence of obesity, according to a report
(PDF downlaod) from the Urban Institute and featured in an article on
MedPage Today. "We find that areas of higher obesity prevalence are more
likely to have greater exposure to the types of food stores likely to offer
less healthy options, even when controlling for differences across
counties," Elaine Waxman, MPP, PhD, senior fellow at the institute's
income and benefits policy center, and colleagues wrote in the study. "The
association between obesity and unhealthy food establishments holds true
in both rural and non-rural areas."

ICYMI: LastPass Data Breach Post Mortem
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One of the most popular VPN services, NordVPN, open-sourced its
Linux client, according to an article on It’s FOSS News.

Enable this setting to squeeze extra juice out of your smartphone’s
battery, according to an article on Lifehacker. Your new device might be
too fast for its battery to keep up.

A quartet of mathematicians from Yorkshire University, the
University of Cambridge, the University of Waterloo and the
University of Arkansas has discovered a 2D geometric shape that does
not repeat itself when tiled, according to an article on the phys.org
website.

Researchers have developed a new molecule that limits magnesium
transport in mitochondria. The drug prevents weight gain and liver
damage in mice who were fed a high-sugar, Western-style diet since
birth. After exposure to the molecule, overweight mice started to lose
weight, according to an article on Neuroscience News.com.

Scientists warn of a spike in “flesh-eating” infections in parts of the
U.S. due to climate change, according to an article from SciTechNews.
Continued warming of the climate would see a rise in the number and
spread of potentially fatal infections caused by bacteria found along parts
of the coast of the United States.

DNA from Beethoven’s hair unlocks medical and family secrets,
according to an article in the New York Times, and widely reported on in
many media outlets. By analyzing seven samples of hair said to have come
from Ludwig van Beethoven, researchers debunked myths about the
revered composer while raising new questions about his life and death.

Two organic compounds essential for living organisms have been
found in samples retrieved from the asteroid Ryugu, buttressing the
notion that some ingredients crucial for the advent of life arrived on
Earth aboard rocks from space billions of years ago, according to an
article on Geo News.

Toyota’s electric cars will have wireless charging, thanks to Israeli tech. A
new deal between Toyota and Electreon will yield built-in wireless
charging for future Toyota EVs, as well as an easy-to-install kit,
according to an article from Jerusalem News.

NASA and Axiom Space revealed a new spacesuit for the Artemis
moon missions, according to an article on Business Insider. The spacesuit
is black, but astronauts have to wear white when they're on the lunar
surface. Axiom put a black cover on the spacesuit to conceal its
"proprietary design."

ICYMI: LastPass Data Breach Post Mortem
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AI ChatBots are all the rage right now. In an article on The Verge, the web
is full of chattering bots, but which is the most useful and for what?
They compare Bard, Bing, and ChatGPT. A similar article appeared on
the PC Mag website.

A prominent Harvard physicist is planning a Pacific expedition to find
what he thinks might be an alien artifact that smashed into the ocean,
according to an article from The Guardian. Avi Loeb announced that he is
organizing a $1.5m ocean expedition to Papua New Guinea to look for
fragments of an object that crashed off the coast of its Manus Island in
2014.

50 years later, the creator of ethernet, Bob Metcalfe, wins computing's
top prize, according to an article on CNET. The network technology first
linked the computers of schools and offices. Now it connects us all to the
internet. He won the 2022 Turing Award.

In 1965, in what became known as Moore’s Law, Gordon E. Moore
predicted that the number of transistors that could be placed on a silicon
chip would double at regular intervals for the foreseeable future, thus
increasing the data-processing power of computers exponentially. Moore,
a co-founder and former CEO of Intel, died March 24, 2023, at his
home in Hawaii at the age of 94, according to an article in the New York
Times.
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compiled by Meemaw

World’s Oldest Dog

Bobi was born in Leiria, Portugal with four
other litter-mates. His owner, Leonel, was a
child when he was born, and said he was almost
put down because his family couldn’t take care
of any more animals. However, Bobi survived
and is 30 years and 266 days old as of February
1, 2023. His breed is Rafeiro do Alentejo, a
breed which has a lifespan of 12 to 14 years..

“The Rafeiro do Alentejo is an excellent farm
and estate watchdog,” according to the
American Kennel Club.

Teen Returns Wallet

In Forest City, Arkansas, college student
Delivonte walked up to use the ATM at Walmart
and found a wallet belonging to a grandmother
named Dee sitting in a shopping cart. He
immediately set out to return the wallet to her.

Finding her name on her drivers license, and
working through an intermediary he found on
Facebook, he drove to the town where she lived
and returned her wallet.

She told a local news station, “God watched
over me. He brought this angel into my life.”

Woman Returns Money

Dianne was walking home one night, and
stopped in a convenience store to get warm. She

found nearly $15,000 worth of cash outside a
gas station. In hopes of finding the owners and
returning the money, she called the police. The
money turned out to belong to a newly married
couple. When members of her community found
out that she has been walking 2.5 miles to and
from work, not having owned a car for five
years, they helped organize a generous gift to
reward her for her honesty. A GoFundMe page
has been set up for her in order to help her get a
car.

Dog Finds Cocaine During Traffic Stop

An Indiana State Trooper made a traffic stop,
but noticed some things that weren’t quite right,
so he called for a K-9 officer. K-9 Cole and his
handler came and Cole alerted the officer to the
scent of narcotics in the semi. The vehicle

Linux Docs
Linux Man Pages

Good Words, Good Deeds, Good News

http://www.die.net/
https://www.breitbart.com/health/2023/02/04/video-dog-condemned-birth-named-oldest-ever-30-years-one-of-kind/?utm_source=newsletter&utm_medium=email&utm_term=b_inspired&utm_campaign=20230211&utm_content=Final
https://www.breitbart.com/pre-viral/2023/02/02/arkansas-grandmother-lost-wallet-returned-college-student/?utm_source=newsletter&utm_medium=email&utm_term=b_inspired&utm_campaign=20230211&utm_content=Final
https://www.breitbart.com/local/2023/02/09/michigan-woman-returns-nearly-15k-she-found-while-walking-receives-jeep-thanks/?utm_source=newsletter&utm_medium=email&utm_term=b_inspired&utm_campaign=20230218&utm_content=Final
https://www.breitbart.com/crime/2023/02/11/photo-k-9-sniffs-out-154-pounds-of-cocaine-during-traffic-stop-give-him-a-treat-please/?utm_source=newsletter&utm_medium=email&utm_term=b_inspired&utm_campaign=20230218&utm_content=Final
https://www.gofundme.com/f/dianne-gordon


PCLinuxOS Magazine Page 39

search turned up 154 pounds of suspected
cocaine inside the truck’s sleeper berth. Testing
proved it to be cocaine.

Nurse Sells Study Notes

Nurse Stephanie was studying for her nursing
board exams alone in 2020. Once she graduated

from nursing school, she got the idea to post her
study notes online, and got a big response.

“I would teach myself to the wall and I would
record it. And then I posted that onto social
media and people loved it,” she recalled, adding
viewers then wanted to purchase her study
notes, so she created an online store. She now
sells her notes on Etsy for $2 per page, with
special prices for page bundles. She sells study
sheets with short concise information. She also
shares some of her pages on Instagram.

In a recent Instagram post, Beggs shared an
“EKG Rhythms Cheat Sheet” that covers atrial
fibrillation, atrial flutter, ventricular tachycardia,
ventricular fibrillation, and premature
ventricular contractions.

Bay City Teen Saves Coworker’s Life

Lillian was working at the Double Tree Motel
when she saw her coworker Rusty slumped over
his desk. When she realized he was

unresponsive, she took action, getting him on
the floor and giving him CPR, which she had
learned to do in high school.

Cardio Pulmonary Resuscitation (CPR) is
described as a “lifesaving procedure performed
when the heart stops beating. Immediate CPR
can double or triple chances of survival after
cardiac arrest,” the American Heart
Association’s website read.

When others found out what she did, she was
recognized by the city and others for saving
Rusty’s life. Rusty said, “I owe my life to
Lillian. If it weren’t for her and her quick
reaction, and her just jumping in … she saved
my life.”

She said she was amazed that the training came
back to her even though it had been several
years since she took the course.
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by David Pardue (kalwisti)

Calcurse is a text-based calendar and scheduling application for the
command line. It helps keep track of events, appointments and daily tasks.
It has lots of functionality, is lightweight, fast, reliable and portable (due to
being text-file based). The PCLinuxOS repositories have ver. 4.6.0
(released in March 2020).

Calcurse's name is a combination of 'calendar' and 'curses' (the name of the
library used to build the user interface). Calcurse is multi-platform. It is
available on Linux, three BSD distributions and macOS (via the
Homebrew project).

The original author of calcurse is Frédéric Coulot, a programmer and
astrophysicist who developed the application in his spare time and first
distributed it in 2004. Since 2011, the project has been maintained by
Lukas Fleischer (Germany), a computer scientist and software engineer.
Many of calcurse's core features since 2017 were designed and
implemented by Lars Henriksen (Denmark).

Calcurse has support for internationalization (UTF-8) and has been fully
translated into six languages besides English: French, Spanish, Portuguese
(Brazilian), German, Dutch and Russian.

You run calcurse by typing calcurse from the Terminal. The screenshot at
top right shows its default layout.

Calcurse divides the screen into three panels: Appointments, Calendar and
ToDo. At the bottom of the screen, there is a Notification bar and a Status
bar (sometimes referred to as a Menu panel). You cycle through the panels
using the Tab key.

Looking at the Status bar, Vim users might notice that calcurse's basic
"motion" keys – Left, Down, Up, Right – are identical to Vim's (i.e., h, j, k,
l). People who have worked with the Nano text editor will find the layout
of calcurse's Status bar familiar.

Calcurse has a minimal learning curve. If you can spare thirty minutes to
watch the tutorials listed in the "Additional Resources" section, you can
learn the program's basics.

How to Make a Repeating Event

This stumped me until I found an explanation in the program's Help file
(which you access by typing " : [colon] help <feature name> ", e.g., " :
help repeat " in the Status bar / Menu panel). This is not covered in the
video tutorials below, so I hope it will save you some frustration.

• Create your appointment (birthday or bill reminder) in the
Appointments panel, as usual.
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• Stay inside the Appointments panel and select the item to be repeated.

• Press " r " for 'repeat.'

• Repetition Type: Choose between daily, weekly, monthly or yearly
repetition by pressing d, w, m or y.

• Repetition Frequency: Indicates how often the item will be repeated.

• For a birthday, anniversary, etc. press "1" which means it will be
repeated every year.

• Other examples: If you go to dine at a restaurant every two days,
choose daily repetition ("d") with a frequency of "2".

• For a quarterly bill, choose monthly repetition ("m") with a
frequency of "3".

When I first began using calcurse, I could not set appointments/events to
repeat because I mistakenly tried to enter the repetition type (e.g., m or y)
again, instead of the numerical value (e.g., 1) that calcurse expects. If you
enter a letter here, calcurse generates an "Invalid frequency" error
message:

• End Date: Specifies when to stop repeating the selected event or
appointment.

• To indicate endless repetition, press "0" and the item will be repeated
forever.

Repeating items are marked with an "*" [asterisk] inside the Appointments
panel to distinguish them from non-repeated items.

How to Delete One Occurrence of a Repeating Event

This is helpful if you use calcurse as a "bill minder" like I do. Once I pay a
monthly bill, I delete it from the Appointments panel so that only
pending/unpaid bills are listed there.

• From inside the Appointments panel, select the (single) item to be
deleted. In this example, I will delete my monthly electricity bill for
March 2023.

• Press " d " for 'delete' item.

Repo Review: Calcurse
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• Do you really want to delete this item?
Answer "y".

• This item is recurrent. Delete all or just one?
Type " o " (for 'one').

• The item will disappear.

• To confirm that calcurse deleted only the March bill, I went to the
calendar for April 1st and looked at the Appointments panel.
"Electricity (Reliant)" is still there for the upcoming month:

If you look in ~/.local/share/calcurse and look at the "apts" file, you can
see that the single day (Mar. 1, 2023) of the deleted occurrence has been
added to the "recipe" as an exception day on which this item is not
displayed.

If you want to completely remove the entry from the data file, select the
option "Delete all occurrences."

Usage in Non-interactive Mode

Calcurse's "non-interactive" mode refers to its use on the command line
(rather than its three-panel ncurses interface). The non-interactive mode is
mainly used for searching; you invoke calcurse with the appropriate
options/flags, the application searches its database, outputs the requested
data and then returns you to the Terminal prompt.

Here are a few examples:

$ calcurse a
This will show all your appointments for today.

$ calcurse t
This will show your to-do list for today.

$ calcurse d 3 ( or, $ calcurse r3 )
This will show your appointments for the next three days.

The fact that calcurse stores your data in a plain text file makes it easy to
find things (e.g., via grep), fix entry mistakes or just review your past
activities. In the example below, I wanted to find my in-laws' birthdays, so
I used grep to search for their surname ("Jones") in the apts file. Grep
returned results very quickly:

Repo Review: Calcurse
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Other Features

Calcurse has other features which I did not experiment with. Calcurse can
import calendars in iCalendar format (.ics) and export your data in either
iCalendar or PCAL format. (PCAL allows you to generate a printable
PostScript version of your calendar).

If you need to synchronize calcurse with your mobile devices, with Google
Calendar or Apple Calendar, there is experimental CalDAV support via a
script called calcurse-caldav. In order to configure this, you must be
running the most recent version of calcurse (4.8.0, released in April 2022)
and follow the detailed documentation here. (Users are cautioned that the
script is alpha software and might still have bugs).

Many of calcurse's settings can be configured from the Configuration
menu (accessed by pressing "C" in the Status bar). For example, once you
are in the interactive configure mode, you can select "l" (for "Layout") and
choose between eight different panel layouts. Pressing "c" (for "Color")
allows you to select different color schemes. All of the program's key
bindings are user-definable, by pressing "k" (for "Keys").

Additional Resources

The most succinct YouTube video tutorials I found were created by Brian
Schell, Brodie Robertson and Derek Taylor from Distrotube:

Schell, Brian. "Scheduling in the Terminal with Calcurse for Appointments
and Todos." YouTube, 23 Mar. 2019. (15 min., 26 sec.)

Robertson, Brodie. "I Wanted a Calendar and Calcurse Is Exactly What I
Need!" YouTube, 24 Mar. 2020. (13 min., 37 sec.)

Taylor, Derek. "Calcurse: Organizer and Scheduling App." YouTube, 22
Oct. 2017. (8 min., 44 sec.)

The program's manual is available in HTML or as a PDF file.

Summary

Calcurse is fast, reliable and incorporates many features into a small
package. It does not require a steep learning curve; if you have previously
worked with Vim or Nano, you should feel right at home with Calcurse's
status bar (aka Menu panel). After using calcurse for two weeks, I have
found it as convenient as Google Calendar.

If you would like to lessen your dependence on Google Calendar,
efficiently manage your schedule and task list while working in a TUI
(Text User Interface) environment, calcurse is an excellent option. I
encourage you to try it.
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Servers: 4-6

INGREDIENTS:

4 cups egg noodles
1 tablespoon butter
1 small onion diced
2 stalks celery diced
⅔ cup frozen peas defrosted
2 can Albacore tuna 5-6 ounces, drained
10 ½ ounces condensed mushroom soup
⅓ cup milk
1 cup cheddar cheese
1 tablespoon parsley

Crumb topping

½ cup panko bread crumbs
1 tablespoon butter melted
½ cup cheddar
1 tablespoon parsley

DIRECTIONS:

Preheat the oven to 425F. Combine topping
ingredients and set aside.

Boil noodles al dente according to package
directions. Drain and rinse under cold water.

Cook onion and celery in butter until tender,
about 5-7 minutes.

In a large bowl combine noodles, onion mixture,
peas, soup, milk, cheese, tuna and parsley. Mix
well.

Spread into a 2qt casserole dish and top with
crumb topping.

Bake for 18-20 minutes or until bubbly.

TIPS:

Serve with a fresh green salad

Nutrition:

Calories: 323 Carbs: 25g Fiber: 2g
Sodium: 689mg Protein: 19g

Donate NOW

PCLinuxOS Recipe Corner Bonus

Tuna Casserole

http://www.gofundme.com/pclinuxos-2016
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter tiles
with which to make as long of a word as you
possibly can. Words are based on the English
language. Non-English language words are
NOT allowed.
2. Red letters are scored double points. Green
letters are scored triple points.
3. Add up the score of all the letters that you
used. Unused letters are not scored. For red or
green letters, apply the multiplier when
tallying up your score. Next, apply any
additional scoring multipliers, such as double
or triple word score.
4. An additional 50 points is added for using all
seven (7) of your tiles in a set to make your
word. You will not necessarily be able to use
all seven (7) of the letters in your set to form a
“legal” word.
5. In case you are having difficulty seeing the
point value on the letter tiles, here is a list of
how they are scored:
0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes should
apply to the game, averaging to 12 minutes per
letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each Sudoku
puzzle. The only way the puzzle can be considered solved correctly is
when all 81 boxes contain numbers and the other Sudoku rules have
been followed.

When you start a game of Sudoku, some blocks will be prefilled for
you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no two
numbers in the same column of a Sudoku puzzle can be the same.
Each row must contain all of the numbers 1 through 9 and no two
numbers in the same row of a Sudoku puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no two
numbers in the same block of a Sudoku puzzle can be the same.
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Possible score 301, average score 211.

PCLinuxOS Puzzled Partitions
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ABSURDITY AMUSING

APRIL FOOL'S DAY CHICANERY

CHILDISH COMICAL

DECEPTION DUPE

FOOL'S ERRAND FOOLISH

GULLIBLE HILARIOUS

HOAX HOODWINK

HUMOROUS INFANTILE

JESTER JOKER

KOOKY LIGHTHEARTED

MISCHIEVOUS MISLEAD

MOCKERY NONSENSE

OUTRAGEOUS PRACTICAL JOKE

PRANKSTER PREPOSTEROUS

QUIRKY RIDICULOUS

SCAM SCHEME

SENSE OF HUMOR SURPRISE

TOMFOOLERY TRICKERY

UNWITTING VICTIM

WILD ZANY
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1. Given to idiosyncrasies; strange in a somewhat
silly, awkward manner.

2. A specific act of ridicule or derision.
3. The act or practice of lying, misleading, or

otherwise hiding or distorting the truth.
4. Foolish trifling; ridiculous behavior; nonsense.
5. Playful in a naughty or teasing way, troublesome

or irritating.
6. Displaying or suggesting a lack of maturity;

childish.
7. Someone who plays practical jokes on others.
8. A person who is easily deceived or is used to carry

out the designs of another.
9. Being well beyond the bounds of good taste.
10. Easily deceived or duped.
11. Comical or ludicrous because of incongruity or

strangeness.
12. The state or quality of being inconsistent with

obvious truth, reason, or sound judgment.
13. To deceive or swindle by deception.
14. April 1 characteristically marked by the playing of

practical jokes.
15. A foolish undertaking, especially one that is

purposeless, fruitless, nonsensical, or certain
to fail.

16. A fool or buffoon at medieval courts.
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Posted by brisvegas, February 28, 2023, running Mate. Posted by Meemaw, March 3, 2023, running Xfce.

Posted by parnote, March 22, 2023, running Xfce. Posted by The CrankyZombie, March 4, 2023, running KDE.
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